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1.

FIELDBUS PLUG

Modbus RTU

Modbus is a master-slave protocol and only one device can transmit on the line at any time.
The master (which in most cases is a PLC) manages the exchanges and only it can take the
initiative. It interrogates each of the slaves in succession and no slave can send a message un-
less it is invited to do so. The master repeats the question when there is an incorrect ex-
change, and declares the interrogated slave absent if no response is received within a given
time. If a slave does not understand a message, it sends an exception response to the master
who may or may not repeat the request.

The Modbus protocol is a fieldbus protocol that provides full control and status information
of the softstarter, reading as well as writing of parameters. Through the fieldbus it is possi-
ble to start and stop the motor, read out currents and frequency, get information about pro-
tections, warnings, faults and much more.

See chapter 8 in the Installation and commissioning manual, document 1SFC132081M0201,
for fieldbus related settings.

Before the Modbus RTU can be taken in operation following parameters must be set in the
softstarter:

— Parameter 12.2 FB interface connector set to FbPlug.

— Parameter 12.3 Fieldbus control set to On (if using fieldbus only to monitor this parameter
can be set to Off).

— Parameter 12.4 Fieldbus address set to an available Modbus slave id. In the examples (sec-
tion 4) the fieldbus address is set to 47, but this parameter can be set to any value be-
tween 1-247.

The parity and number of stop bits are automatically detected by the fieldbus plug.

The baud rate depends on the configured fieldbus address according to the table below:

Fieldbus address Baud rate bits/s
1to32 9600

33to 65 19200

66 to 98 57600

99 to 247 19200

] Information
_|h| After changing any of the communication parameters it is needed to perform a
power cycle of the device for the parameter values to be taken into effect. Or an-
other way for a communication parameter value change to be taken into effect is
to set parameter 12.2 FB interface connector to “None” and then set it back to
“FbPlug”.

If there is no message passed between the PSTX softstarter and the Fieldbus
plug for more than 100ms, the PSTX softstarter will trip on fieldbus communica-
tion failure protection (P1EOO) and with the default configuration, the motor will
be stopped. If the fieldbus communication system is setup in such a way that
commands/requests are not continuously passed between the PLC and
softstarter, this protection function should be disabled. The parameter 19.4
(Fieldbus failure op) can then be set to “Off”.
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FIELDBUS PLUG

Caution!
A The motor may start unexpectedly if there is a start signal present when doing
any of the actions listed below.

— Switching from one type of control to another (fieldbus control/hardwire
control)

— Reset all Settings

2. Modbus Addressing

When talking about Modbus addressing, there is often a misunderstanding about what an
address really is. This section will try to clarify the conventions in this document.

2.1. Protocol Address

The Modbus standard specification uses one kind of address, a two byte unsigned integer (0-
65535).

This is the address that is actually transmitted to the device.

2.2. Modicon Address

Modbus was originally developed by Modicon and the notation used then is still often used
today, though considered obsolete by present standards.

The Modicon notation combines two pieces of information in a single number:
1. Theregister type
2. The register number

A register number offset defines the type and makes it possible to translate between the two
types of addresses.

Table 1 Register types and ranges

Prefix Register Type Range

Ox Coil 00001-00001
1x Discrete Input 10001-19999
3x Input Register 30001-39999
4x Holding Register 40001-49999

2.3. Translating Modicon address to protocol address

An example:
Modicon address 40002 selects the holding register at protocol address 0001 (40002 — 40001
=1). The protocol address 0001 will be transmitted in the message packet.
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FIELDBUS PLUG

3. PSTX Data

3.1. Digital input telegram

To PLC from the softstarter.

Use Modbus function code 01, Read Coil Status.

Protocol Modicon Bit Data Description

Address Address

0000h 00001 0 Auto Mode status! 0 = softstarter control from
fieldbus not allowed

0001h 00002 1 Event status 0 = No active fault/warn-
ing/protection

0002h 00003 2 Ready To Start 0 = A start will probably

cause a fault,
1= A start will probably not
cause a fault

0003h 00004 3 FBT Response O See Fieldbus Tasks

0004h 00005 4 FBT Response 1 See Fieldbus Tasks

0005h 00006 5 FBT Toggle Bit See Fieldbus Tasks

0006h 00007 6 Programmable Digital Input 1 Function of programmable
0007h 00008 7 Programmable Digital Input2 ~ digitalinput, see section 3.2
0008h 00009 8 Programmable Digital Input 3

0009h 00010 9 Programmable Digital Input 4

000Ah 00011 10 Programmable Digital Input 5

000Bh 00012 11 Programmable Digital Input 6

000Ch 00013 12 Programmable Digital Input 7

000Dh 00014 13 Programmable Digital Input 8

O0OEh 00015 14 Programmable Digital Input 9

OOOFh 00016 15 Programmable Digital Input 10

D Auto mode reflects the control state of the Softstarter. This is affected by a combination of:

The Auto mode input signal from the PLC (Digital output telegram).

— The state of the Local/Remote switch on the Fieldbus Plug Accessory.
— The state of the Local/Remote switch on the HMI.

— The parameter “Fieldbus control”.

— The digital input “Fieldbus disable”.
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3.2.

FIELDBUS PLUG

Programmable Digital Inputs

The functions of the programmable Digital inputs are controlled by the parameters Fieldbus
DI 1 through Fieldbus DI 10. The following functions are available for selection:

Function Data

None Value is set to O.
Start feedback Status of Start signal.
Stop feedback Status of Stop signal.

Fault reset feedback

Slow speed reverse feedback

Slow speed forward feedback

Start 1 feedback

Start 2 feedback

Start 3 feedback

Motor heating feedback
User defined feedback
Stand still brake feedback
Emergency mode feedback
Start reverse feedback

Run status

TOR status

Line

Phase sequence

Event group O status
Event group 1 status
Event group 2 status
Event group 3 status
Event group 4 status
Event group 5 status
Event group 6 status
Sequence 1 Run status
Sequence 2 Run status
Sequence 3 Run status
Sequence 1 TOR status
Sequence 2 TOR status
Sequence 3 TOR status

Run reverse status

Enable status

Digital InO status

Status of Reset signal.

Status of Slow speed reverse signal.
Status of Slow speed forward signal.
Status of Start 1 signal.

Status of Start 2 signal.

Status of Start 3 signal.

Status Motor heating signal.

Status of User defined protection signal.
Status of Stand still brake signal.
Status of Emergency mode signal.
Status of Start reverse signal.

1 = Indicates when the softstarter gives voltage to the
motor.

Top of Ramp. 1 = Indicates that motor runs on full volt-
age.

Line or Inside Delta Connection; O = Line, 1 = Delta.
0=1L1,L2,L3;1=1L1,L3,L2.

0 = No active events present in group O.

0 = No active events present in group 1.

0 = No active events present in group 2.

0 = No active events present in group 3.

0 = No active events present in group 4.

0 = No active events present in group 5.

0 = No active events present in group 6.

Run status of sequence connected motor 1.

Run status of sequence connected motor 2.

Run status of sequence connected motor 3.

Top of Ramp status of sequence connected motor 1.
Top of Ramp status of sequence connected motor 2.
Top of Ramp status of sequence connected motor 3.

1 =Indicates when the softstarter gives voltage to the
motor after a reverse start.

Status of Enable signal.

Status of internal digital input InO.
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3.3.

FIELDBUS PLUG

Function

Data

Digital Inl status

Digital In2 status

Local control status

Cancel brake feedback

Pump cleaning auto status
Pump cleaning forward status
Pump cleaning backward status
External digital 1DIO status
External digital 1DI1 status
External digital 1DI2 status
External digital 1DI3 status
External digital 1D14 status
External digital 2DI5 status
External digital 2DI16 status
External digital 2DI7 status
HW DI Start status

HW DI Stop status

Ready to start (line contactor)

Status of internal digital input In1.

Status of internal digital input In2.

0 = Remote control, 1 = Local control (HMI).
Status of Cancel brake signal.

Status of automatic pump cleaning.

Status of forward pump cleaning.

Status of reverse pump cleaning.

Status of external digital input 1DIO.

Status of external digital input 1DI1.

Status of external digital input 1DI2.

Status of external digital input 1DI3.

Status of external digital input 1DI14.

Status of external digital input 2DI5.

Status of external digital input 2DI6.

Status of external digital input 2DI7.

Status of the hard wire internal digital input Start.
Status of the hard wire internal digital input Stop.

Same conditions as the Ready To Start bit except that
the incoming three phase voltage condition is excluded.
The bit can be used when a line contactor is connected.

Analog input telegram

To PLC from the softstarter.

All analog data is represented as 16-bit values.
Use Modbus function code 04, Read Input Registers.

A protocol for Fieldbus tasks is used to read and write parameters. It is applicable for all

fieldbuses.
Protocol Modicon Data Representation
Address Address
0200h 30513 FBT Return Value See Fieldbus Tasks
0201h 30514 Programmable Analog Input 1 Function of programmable
0202h 30515 Programmable Analog Input2 ~ 2naloginput, see section
0203h 30516 Programmable Analog Input 3 34
0204h 30517 Programmable Analog Input 4
0205h 30518 Programmable Analog Input 5
0206h 30519 Programmable Analog Input 6
0207h 30520 Programmable Analog Input 7
0208h 30521 Programmable Analog Input 8
0209h 30522 Programmable Analog Input 9
020Ah 30523 Programmable Analog Input 10
STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
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3.4.

FIELDBUS PLUG

Programmable Analog Inputs

The functions of the programmable analog inputs are controlled by the parameters Fieldbus

Al 1 through Fieldbus Al 10. The following functions are available for selection:

Function

Representation

None

Phase L1 current!
Phase L2 current!
Phase L3 current?
Active power (hp)
Active power
Apparent power
Mains voltage

Power factor

Motor voltage
Active energy (resettable)
EOL time to trip

Mains frequency

Max phase currentl

Motor current

Motor run time (resettable)
Motor temperature

Motor temperature percent
Number of starts (resettable)

Phase sequence

PT100 temperature

PTC resistance

Reactive energy (resettable)
Reactive power

Remaining time to start
Thyristor temperature
Thyristor temperature percent
EOL time to cool

Top event code

Motor current in percent of IE

Thyristor run time (resettable)

Value is set to O
Value = 1000 = 100A
Value = 1000 = 100A
Value = 1000 = 100A
Value = 1000 = 10hp
Value = 1000 = 10kW
Value = 1000 = 10kVA
Value = 1000 = 100V

Value=100=>1
Example: 87 = 0.87

Value = 100 = 100%
Value = 1000 = 10kWh

Value =100 = 100s
Value = 65535 = No overload
Value = 0 = Trip already occurred

Value = 1000 = 100Hz
Value = 1000 = 100A
Value = 1000 = 100A
Value =100 = 1000h
Value =100 = 100°C
Value =100 = 100%
Value =1 =100

Value =0 = L1->L2->L3
Value =1= L1->L3->L2
Value = 2 = No sequence detected

Value =n=n/10-50°C
Example: 750 = 25°C

Value =100 = 100Q
Value = 1000 = 10kVArh
Value = 1000 = 100VAr
Value =100 = 100s
Value =100 = 100°C
Value =100 = 100%
Value =100 = 100s
Value =1000 = 1000
Value =100 = 100%
Value =1 = 10h
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FIELDBUS PLUG

Function Representation

Motor connection Value = 0 = auto
Value =1 = In-line
Value = 2 = Inside delta - Ul
Value = 3 = Inside delta - IU
Value = 4 = 2-phase L1 shorted
Value = 5 = 2-phase L2 shorted
Value = 6 = 2-phase L3 shorted

Phase L1 current high range? Value = 100 = 100A
Phase L2 current high range? Value = 100 = 100A
Phase L3 current high range? Value =100 = 100A
Active power (hp) high range? Value =100 = 100hp
Active power high range? Value =100 = 100kW
Apparent power high range? Value = 100 = 100kVA
Reactive power high range? Value = 100 = 100kVAr
Max phase current high range? Value = 100 = 100A
Max motor current high range? Value = 100 = 100A
Active energy high range? Value =1 = 10000kWh
Reactive energy high range? Value =1 = 10000kVArh
Number of starts (high precision) Value=1=1

D Phase current L1, L2 and L3 indicate the current through the softstarter, while the Max
phase current is always the line current.

2 High Range alternatives are available for a few signals where there is a possibility for the
values to wrap. The values are 16-bit so the maximum value for each signal is 65535. The High
Range alternatives have different scaling and will never wrap around but instead have lower
precision.

3.5. Digital output telegram

From PLC to softstarter. Use Modbus function code 15 (OFh), Force Multiple Coils.

Protocol Modicon Bit Data Description
Address Address
0100h 257 0] Start Commence a start when signal is set.
0101h 258 1 Stop Commence a stop when signal is negated.
0102h 259 2 Fault reset Reset signal for possible events.
0103h 260 3 Auto mode This must be set for controlling the motor.
0104h 261 4 Slow speed Perform slow speed reverse when signal is
reverse set.
0105h 262 5 Slow speed Perform slow speed when signal is set.
forward
0106h 263 6 Spare
0107h 264 7 Startl Startl if sequence start.
0108h 265 8 Start2 Starte if sequence start.
STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
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FIELDBUS PLUG

Protocol Modicon Bit Data Description
Address Address
0109h 266 9 Start3 Start3 if sequence start
010Ah 267 10 Motor heating Perform motor heating when signal is set
010Bh 268 11 Stand still brake Perform stand still brake when signal is set
010Ch 269 12 Start reverse Commence a reverse start when signal is
set
010Dh 270 13 Spare
O10Eh 271 14 Emergency Set to “1” to enable emergency mode
mode
010Fh 272 15 FBT Toggle Bit See Fieldbus Tasks
0110h 273 16 User defined Set to “1” to trigger user defined protection
trip
Ol11ih 274 17 Switch to Switch to remote control when signal is set
remote control (rising edge triggered)
0112h 275 18 Pump cleaning Perform automatic pump cleaning when
automatic signal is set
0113h 276 19 Pump cleaning Perform forward pump cleaning when
forward signal is set
0114h 277 20 Pump cleaning Perform reverse pump cleaning when signal
reverse is set
0115h 278 21 K4 relay Set “1” to activate the internal K4 output
command relay. Note that parameter 10.4 K4 function
has to be set as “Fieldbus”
O116h 279 22 K5 relay Set “1” to activate the internal K5 output
command relay. Note that parameter 10.5 K5 function
has to be set as “Fieldbus”
0117h 280 23 K6 relay Set “1” to activate the internal K6 output
command relay. Note that parameter 10.6 K6 function
has to be set as “Fieldbus”
0118h 281 24 1DOO relay Set “1” to activate the external 1DOO output
command relay. Note that parameter 11.9 1DOO
function has to be set as “Fieldbus”
0119h 282 25 1DO1 relay Set “1” to activate the external 1DO1 output
command relay. Note that parameter 11.10 1DO1
function has to be set as “Fieldbus”
O11Ah 283 26 2DO2 relay Set “1” to activate the external 2DO2 output
command relay. Note that parameter 11.11 2D0O2
function has to be set as “Fieldbus”
011Bh 284 27 2DO3 relay Set “1” to activate the external 2DO3 output
command relay. Note that parameter 11.12 2DO3
function has to be set as “Fieldbus”
011Ch 285 28 Spare
011Dh 286 29 Spare
O11Eh 287 30 Spare
O11Fh 288 31 Spare
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FIELDBUS PLUG

3.6. Analog output telegram

From PLC to the softstarter.

All analog data is represented as 16-bit values.
Use Modbus function code 16 (10h), Preset Multiple Registers

Protocol Modicon Data Representation
Address Address
0300h Address offset

0300h 40769 FBT Control Word This register is used to read parameters (see
fieldbus tasks)

0301h 40770 Fieldbus AO 1 (FBT Parameter 12.37 Fieldbus AO1 decides the use

Argument 2 or In- of this register. If set as "FBT Argument 2, it is
ternal analog out- used to write parameters and set time (see
put) fieldbus tasks). If set as “Internal analog out-

put” this value of this register controls the in-
ternal analog output. Note that parameter 10.8
AO type needs to be set as “Fieldbus [%]”

0402h 40771 Fieldbus AO 2 (FBT Parameter 12.38 Fieldbus AO2 decides the use
Argument 3 or Ex- of this register. If set as "FBT Argument 3”, it is
ternal analog out- used to write parameters and set time (see
put) fieldbus tasks). If set as “External analog out-
put” this value of this register controls the ex-
ternal analog output. Note that parameter 11.14
1A0O0 type needs to be set as “Fieldbus [%]”

4. Modbus RTU - A set-up example

4.1. Softstarter PST Modbus RTU communication

This document describes an application example between a Modbus RTU master (PLC CPU,
PC, etc.) and the ABB softstarter PSTX equipped with an Anybus Modbus-RTU module. In this
example the softstarter address is 47.

Please always use the actual softstarter manuals. In this particular example following docu-
ments has been used:

Modbus RTU FBP Fieldbus Plug MRP21. FBP technical description 2CDC194001D0203.

Softstarter PSTX Installation and commissioning manual, document 1SFC132081M0201.

4.2. Settings

1. Set the softstarter address and field bus communication.
Change the address of the softstarter to 47 (Fieldbus Address) and enable fieldbus con-
trol (Fieldbus control = On).

2. Set the communication parameters.
The communication parameters are:
1 Start bit, 8 Data bits, the Parity will be adapted to the master.
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FIELDBUS PLUG

The baud rate is mapped to the slave address; e.g. the baud rate to the slave 47 is 19200.
Therefore the master and the slave will have the communication parameters:
1 start bit, 1 stop bit, 8 data bit, even parity, 19200 baud.

3. Select the FBP interface.
The previous changes are taken in effect when the fieldbus interface is changed.
Change parameter FB interface connector to FbPlug.

4.3. Read binary input telegram

FC=1
Address: 0000H Modbus FBP
MRP21-FBP
Slave NR.47
Modbus Request \
Master —
RS485 / Modbus RTU Softstarter
Response
E.g: Read 16 bit starting at the address: OOO0OH
Request:
2F 01 00 00 00 10 3B 88
e e )
N~ — 0
<t o g -
()] 1 — —
S0 3 & ¢
w L < S O
Response:
2F 01 02 00 00 51 FA
| -
N~
s ° g
> 1" > O
T @ x
() LLI{ ] Q
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FIELDBUS PLUG

4.4. Write binary output telegram

. FC=15

. Address: 0100H Modbus FBP

5 M P21-FBP

Slave NR.47
Modbus Request \
Master —
RS485 / Modbus RTU Softstarter
Response

E.g: Write 16 bit starting at the address: 0100H

Request:
2F OF 01 00 00 10 02 00 00 27 41

—_— —_—

~ 0

9 3 o o 3

(O] — Py = + o

T -

n o < 9 ] o] (U]

Response:

2F OF 01 00 00 10 53 B5

e bd e

N~ w0

<+ 0 3 o

Q@ =S 5

(L3 B g

[ < 9 (U]}
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4.5. Read analog input telegram

FC=4
Address: 0200H Modbus FBP
MRP21-FBP
Slave NR.47
Modbus Request \

Master ——

RS485 / Modbus RTU

 —

Response

Softstarter

E.g: Read analog output words 2 & 3. Phase L1 current and Phase L2current with default set-
tings.

Request:
2F 04 02 01 00 02 27 FD

_—t ed

Slave 47
FC =04
Address
2 words
Output

Response:
2F 04 04 00 00 00 00 35 86

_— d

N~
s 8 o
RIS U
»n OIL < =2 = (@]
WO: Phase L1 current
W1: Phase L2 current
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4.6. Write analog input telegram

FC =16
Address: 0300H Modbus FBP
MR P21-FBP
Slave NR.47
Modbus Request \
Master —
RS485 / Modbus RTU Softstarter
Response

E.g: Write analog output words 1 & 23. FBT Control Word and FBT Argument 2.

Request:
2F 10 03 00 00 02 04 00 OO0 00 00 78 77

—_— _—t ad

N~ [0)] 2] [0)]
9 9 2 3
g 5 g o U
© yo! s 2 b x
s & ~« < 2 2 6
WO: FBT Control Word
W1: FBT Argument 2
Response:
2F 10 03 00 00 02 47 cC2
e e e
[}
S 9 0 S5
4] s 5
S on o o (@)
8 0 o 3 &
" < o (O]
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5.1.

5.2.

5.3.

FIELDBUS PLUG

Fieldbus Tasks

By using Fieldbus Tasks it is possible to read/write parameters and to set the real-time clock.

Which task to execute is selected by filling in the FBT Control Word. There are three signals
for arguments to the task:

FBT Argument 1 is packed together with the Task ID in the FBT Control Word.

There are two additional 16-bit arguments in separate analog output signals, FBT Argument 2
and FBT Argument 3.

To control when the task is executed, the digital output signal FBT Toggle Bit shall be
changed. The softstarter will detect the change, execute the task, fill in the return values, and
toggle the digital input signal FBT Toggle Bit as acknowledgement. Thus, the return values
must be disregarded if the two toggle bits have different value.

FBT Control Word

The control word is a 16-bit analog output value sent from the PLC to the softstarter. It con-
sists of a Task ID and an 11-bit argument packed together.

15 14,13,12, 11 10,9,8,7,6,5,4,3,2,1,0
- Task ID - Argument 1

Task ID

The task identifier controls which function should be performed.

Task Task Response ID

ID Positive  Negative
0] No task 0] -

1 Request parameter value, lower word 2

2 Change parameter value 1 2

3 Set date and time 1 2

4 Request parameter value, upper word 1 2

Response ID

The response ID is the softstarter response to a task. It tells whether a task was executed
successfully. If there was an error, an additional error code is returned in the FBT Return Value
analog input. The Response ID is transmitted as two digital input signals, FBT Response O
and FBT Response 1.

ResponseID FBT Responsel FBT Response O Explanation

0] 0 0 No response
1 0 1 Task executed
2 1 0 Task cannot be executed
(with error number)
3 1 1 Reserved.
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5.4.

5.5.

5.5.1.

5.5.2.

5.6.

5.6.1.

5.6.2.

FIELDBUS PLUG

Error codes

The following error codes are sent when a task cannot be executed.

Error code Explanation

lllegal parameter number
Parameter value cannot be changed
Lower or upper limit violated

Invalid argument

No error

ol | pdh|lwW|=|O

Invalid task number

Request parameter value, lower word

This task reads the lower 16 bits of the specified parameter’s value. See chapter 5.9 for pa-
rameter number and value scaling information.

Arguments

— FBT Argument 1: parameter number.

Return Value
— Response ID 1 and parameter value in FBT Return Value on success.

— Response ID 2 and error number in FBT Return Value on failure.

Change parameter value

This task writes a specified value to a parameter. See chapter 5.9 for parameter number and
value scaling information.

Arguments

— FBT Argument 1: parameter number.

— FBT Argument 2: parameter value (lower word)

— FBT Argument 3: parameter value (upper word)

Return Value
— Response ID 1 on success.

— Response ID 2 and error number in FBT Return Value on failure.
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5.7. Set date and time

This task updates the real-time clock on the softstarter. The date and time fields have the fol-
lowing limits:

— Year: 0-63 (2000-2063)
- Month:1-12

- Day:1-31

- Hour:0-23

— Minute:0-59

— Second:0-59

5.7.1. Arguments

FBT Argument 2: year, month, day and least significant bit of seconds.

15 14,13,12,11,10,9 8,7,6,5 4,3,2,1,0

sO year month day

FBT Argument 3: hour, minute, seconds, bit 1-5.

15,14,13,12,11 10,9,8,7,6,5 4,3,2,1,0

Hour minute seconds, bit 1-5

5.7.2. Return Value

— Response ID 1 on success.

— Response ID 2 and error number in FBT Return Value on failure. In case the supplied time
didn’t differ from the set time, error code 5 (no error) is used.

5.8. Request parameter value, upper word

This task reads the upper 16 bits of the specified parameter’s value. See chapter 5.9 for pa-
rameter number and value scaling information.

5.8.1. Arguments

— FBT Argument 1: parameter number.

5.8.2. Return Value

— Response ID 1 and parameter value in FBT Return Value on success.

— Response ID 2 and error number in FBT Return Value on failure.

STATUS SECURITY LEVEL DOCUMENT ID. REV. LANG. PAGE
Approved Public 1SFC132092M0201 E en 18/31

© Copyright 2019 ABB. All rights reserved.




5.9.

5.9.1.

FIELDBUS PLUG

Parameter numbers and values

To access parameters from the fieldbus a unique parameter number is needed, this can be
found in document 1SFC132081M0201, Chapter 7.19 Complete parameter list, Table 5.

Since the parameter values need to be represented as integers on the fieldbus while, the pa-
rameter values with greater precision need to be scaled. In document 1SFC132081M0201,
Chapter 7.19 Complete parameter list, Table 5, there is a column specifying the number of
decimals for each parameter.

Parameter values that are read from the fieldbus needs to be divided by 1Qnumbers of decimals

Parameter values that are written from the fieldbus needs to be multiplied by 10numbpers of deci-

mals

For example:
The parameter Kick start time has parameter number 24 and 2 decimals. To read this param-
eter:

=

Set FBT Task ID to 1.

2. Set FBT Argument 1 to 24 to specify the parameter.

3. Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.
4. Response ID 1 should now contain value 1, indicating success.
5

. FBT Return Value contains the value 50 (this is an example and depends on the actual
value set).

6. The return value should be interpreted as 50/102 = 0.5s.

To change the Kick start time parameter to 1s:
1. Set FBT Task ID to 2 for Change parameter value.

2. Set FBT Argument 1 to 24 to specify the parameter.
3. Set FBT Argument 2 to 1*10? = 100.
4

. Set FBT Argument 3 to 0 as 100 <= 65535 which means it doesn’t require more than 16
bits.

ur

Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.

[9)]

. Response ID 1 should now contain value 1, indicating success.

Negative values
Negative values are represented internally using 32-bit two's complement numbers.

Example:
Setting parameter 17.5 PT100 reset temp (parameter number 249) to a value of -25°C:

The two’s complement of -25 is FFFFFFE7hex. The upper word is FFFFhex and the lower FFE7hex,
in decimal notation 65535 and 65511.

1. Set FBT Task ID to 2 for Change parameter value.

Set FBT Argument 1 to 249 to specify the parameter.

Set FBT Argument 2 to 65511 to specify the lower word.

Set FBT Argument 3 to 65535 to specify the upper word.

Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update.

o v o» woN

Response ID 1 should now contain value 1, indicating success.
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6.1.

Example application with Automation

Builder

FIELDBUS PLUG

This section shows a demo about how to start and stop motor by sending commands from
fieldbus that is controlled by Programmable logic controller (PLC). We use Automation Builder
as an example platform and show the demo about building such communication setting.

Create a new project in Automation Builder

We perform the following steps in Automation Builder 2.1 for PLC AC500 PM573.

1. Open Automation Builder

2. Select File->New Project->AC500 project->OK

3. Select the correct PLC CPU in Search object name ...-> Add PLC

Categories £ |,- object name y
H Etg - E:gg xi Name Short Description G
""" ) 07KT98-ARC-AD 07KT98-ARCNET adapter ¢
07KT98-ARC-DP-AD 07KT98-ARCNET-DP adap
07KT98-ARC-ETH-AD 07KTS8-ETH-ARCNET ad=

07KT98-ARC-ETH-DP-AD
07KT98-ETH-DP-AD
£ AC500 PM554

] AC500 PM554-ETH
1 AC500 PM556-ETH
] AC500 PM5B4

£ AC500 PM564-ETH
£ AC500 PM566-ETH
AC500 PM572

171 AC500 PM573-ETH
£

07KT98-ARCNET-ETH-DP
07KT38-ETH-DP adapter s
8DI/6DO-T, 24VDC or 115
8DI/6DO-T, 24VDC, Ethemr
8DI/6DO-T, 24VDC, Ether
EDI/EDO-T/2A1/1A0, 24VI
EDI/EDO-T/2A1/1A0, 24VI
6DI/6DO-T/2A1/1A0, 24VI
ACS00CPU 128kB

ACEDD CPU 512kB, Ethemi ¥
>

Close this dialog after each transac Display all versions

Close

4. Check that the correct device type is selected by double clicking the device name in De-
vices field. Check that the correct Terminal Base Type is also selected for the tag for Hard-

ware.

Devices * 3 X

PLC_PSTX X

=2 psix
-| (7 PLC_PSTX (PM573-ETH - TB521-ETH)
= @l] psh_control
& app
10_Bus
= Interfaces
m COM1_Online_Access (COM1 - Online Access)
m COM2_Online_Access (COM2 - Online Access)
m FBP_Online_Access (FBP - Online Access)
= E Ethernet
@ emiEHD
@ Protocols (Protocols)
= @ Extension_Bus
Bd  Sot_1(Tas24)
B  Sot_2(Tasz9)

PM573-ETH Parameters

PM573-ETH Hardware

Information

PLC ACS500 V2

PMBxx Type:

Terminal Base Type:

PM573-ETH

TB521-ETH

[] change to ACS500 V3 PLC

Change PM [ TB type
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FIELDBUS PLUG

6.2. Add Modbus RTU master to project
1. Right click on one of the comports and select Add object

Devices * o X
=5 pstr -
= 7] PLC_PSTX (PM573ETH - TBS21ETH)
= Eﬂ psh_contral
) app

=g Interfaces
47 [coM1_Online_Access (COM1 - Online Access) |

m COM2_Cnline_Access {COM2 - Online Acces: Copy
B45) FBP_Orline_Access (FBP - Online Access) Paste |
ETH
=-gim Ethernet % ocut
ETH1 1
g ETHL) % Delete
ﬂ Protocols {Protocols)
=l Extension_Bus Rename
B slot_1(Tas24) Add object
B skt 2(TAs2q) Update objects
=) Add Folder...
[{ EditObject
Compare Objects

2. Select COM1 - Modbus and click Replace object

Replace object : COM1_Online_Access X

Object path:
PLC_PSTXnterfaces\COM1_Online_Access

Object name: COM1_Modbus

Categories ~ | | Search object name... L
gcnpr‘”g I Name Short Description  Version  Order Number
- Serial prot
Sna protacols @ COM1 - ASCII 2700
[EICOM1 - C531-Bus 2700
COM1 - Modbus 2700
COM1 - Mutti 2700
gCOI\M - SysLibCom 2700
L[ Seript

Clese this dialog after each transaction Dizplay &l versions

Reset filter Replace object Close

3. Double click interfaces, COM1_Modbus, from the device tree. Set RTS control to Telegram
and Operation mode to Client for COM1 - Modbus Parameters in COM1_Modbus

Devices * 1 X 4. COM1_Modbus X
=3 astr Ed
= PLC_PSTX (PM573-ETH - TES21-ETH) COM1 - Modbus Parameters Parameter Type Value
=Bl pstx_control X % Enable login Enumeration of BYTE Digabled
& App e = % RTS control Enumeration of BYTE
10_Bus & Telegram ending value WORD(0..65535) 3
== Interfaces & Baudrate Enumeration of DWORD 19200
ﬂ; COM1_Modbus {COM1 - Modbus) % Parity Enumeration of BYTE even
COM2_Online_Access (COM2 - Online Access) & Data Bits Enumeration of BYTE 8
m FBP_Online_Access (FBP - Online Access) @ Stop Bits Enumeration of BYTE 1
= E Ethernet % Run on config fault Enumeration of BYTE No
@ emHiEmY # Operation mode Enumeration of BYTE
ﬁ Pratocols (Protocols)  Address BYTE(0..255) i}
= ﬂ Extension_Bus
B sot_1(Tas29)
B4 slot_2(Tas29)
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6.3. Build a START-STOP program

We perform the following steps for building our start-stop demo program in CoDeSys.

1. Open CoDeSys by double clicking your application in Devices file in Automation Builder,
if it is not opened yet.

=2 pstr
= PLC_PSTX (PM573-ETH - TB521-ETH)

= @1] |pstx_mn1ml

¥ App
10_Bus

= Interfaces
m COMi_Online_Access (COM1 - Online Access)
m COM2_Online_Access (COM2 - Online Access)
m FBP_Online_Access (FBP - Online Access)

= &5 Ethernet

2. Delete the default POU by right click on it and select.

m CoDeSys - Application.AC500PRO - -
File Edit Project Insert Extras Online Window Help

= RE

C —

Add Object...
Rename Object...
Edit Object

Copy Object
Delete Object
Convert Object...
Export object...
Object Properties...

3. We choose to use LD as the language of the POU here by right click POUs -> Add Object...
->Insert Name of the new POU -> Choose “LD” for “Language of the POU” -> OK.

% CoDeSys - Application. AC500PRO* . B  NewPoU x
File Edit Project Insert Extras Online Window Help
Mame of the new POU dema
H @B
Tppe of PO Language of the POL Cancel
- I " Program L
add ObJECt':‘ " Function Black & LD
:\enar:ne Object... © Function « FED
ol “‘J'Et“ Retumn Type " SFC
Copy Object BO0L J rosT
Delete Object  CFC
Convert Object...
Export object..

4. Open the newly created POU by double click it and select the first network, create a con-
tact (by CTRL+K) and two coils (by CTRL+L).

%y demo (PRG-LD) = ol =
0001|PROGRAM dema
0002VAR
0003 END_VAR
4 |1 b
Ll
299 297
— | (—
277
4( )7
< 1 >
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5. Name the contact START by changing the ??? to START, select type BOOL.

r

Declare Variable

o1 I ==

Class

Syrmbol list

(Glohal_“ariables

[sTART [pooc =]
Cancel
Initial Walue Address
LI I J I [~ CONSTANT
[~ BETAIN

Comment:

[~ PERSISTENT

6. Name the coils “BITVAL[1]” and “BITVAL[2]”, set the type to “ARRAY [1..16] OF BOOL".

o — =
I\/AR LI ISTART A A 5] OF BOOL] R
Cancel
Symbol list Initial Walue Address
Global_Variahles - 5
I = —I I —I I [~ CONSTANT
Comrment; [~ BETAIN

[~ PERSISTENT

7. Add a second network by CTRL+T and add a single coil (by CTRL+L) named “BITVAL[4]”

%, demo (PRG-LD)
D001PROGRANM demo

VAR
0003 START-BOOL]
BITVAL: ARRAY [1..16] OF BOOL;
END_VAR
4 |1 2
0001
START BITVAL[1]
l {
— | {
BITVAL[2)
BITVALL4]
{
{
<« [ »

8. Add another network by CTRL+T. Create a function block “BLINK” by CTRL+B and select
Standard Function Blocks -> Util.lib -> signals-> BLINK(FB)->Ok.

Func
User defined Funciion Blocks
Standard Programs

User defined Programs

Jstandard Function Blocks -

\Program Files (x8)\ABBY AutomationBuilder\ CODES'YS12.3.8.554 Librans ecsfe lib
[l \Progrem Files (86)\ABBA Automation Builder| CODES'YS\2.3.9.65Libran UtiLlia
analog monitors

(Cibit/byte functions

B[ Jeortroller

(CQfunction manipulatars

(CAmathematical functions

B-{Jsignals =

Euru- (FE)

FREQ_MEASURE (FE)
GEN (FB)
\Frogram Files (x86)\Camman Files\CAA Targets\ABE_ACSI0LACE00_Y124Libran/ SysLibsh SysLib Time.lia
\Program Files (B6)\Common Files\CA4 Targets\ABE_ACS004ACE00_V124LibranA SysLibst Sys Taskinto.ib
\Program Files (xB6)\Cammon Files\CaA Targets\ABE_ACS004ACS00_Y124LibraryABusDiag lib
-

\Program Files (B6)\Common Files\CAd Targets\ABE_ACS004ACE00_V124LibranA SysExt_ACED0_10lib

]
)
]
\Program Files (xB8\Common Files\CAA-Targets\ABB_ACE00LACE00_V124Librany Sysint_ACE00_W10.lib
)
]
]

\Program Files (xB6\Commaon Files\CAA-Targets \ABB_ACEI0NACE00_ V124 LibranAMODBUS_EXT_ACE00_V2I +
I \ 3

<

[+ Stuctured

\Prugram Files (GE)\ABB\AutomationBuilder\ CODES'Y'S12 3.8 554 Libransstandard lib B

\Program Files (xB6)\Cammon Files\Cia Targets\ABE_ACSODLACS00_V124LibranAMODBUS_ACS00_V10lb

0K I
Cancel
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9. We name the BLINK function block as blink. We set t#2ms for TIMELOW and TIMEHIGH.

10. Continue to create a function block “COM_MOD_MAST” by CTRL+B and select Standard
Function Blocks -> MODBUS_AC500_V10.LIB -> COM_MOD_MAST(FB) -> OK.

Input assistant

==

B

User defined Function Blocks

Standard Frograms
User defined Programs

35tandard Function Blocks
YWPROGRAM FILES (<86)\ABB\AUTOMATIONBUILDERLCODESYS42 3 9 854 LIBRARYSTANDARD LIB
YPROGRAM FILES (<86)\ABBYALTOMATIONBUILDER,CODES YS! 2.3 .8 5B LIBRARYYECSFCLIB
YWPROGRAM FILES (<86)\ABB\AUTOMATIONBUILDER\CODESYS4,2.3.9.554 LIBRARY\UTILLIB
YPROGRAM FILES (<86)\ COMMON FILES\CAATARGETS\ABE_ACE004ACE00_V12\LIBRARY,SYSLIBSY SYSLIBTIME.LIB
YPROGRAM FILES (<86)\ COMMON FILES\CAA TARGETS\ABBE_ACS00VACE00_V12\LIBRARY,SYSLIBSY SYSTASKINFO.LIB
)
)
)

OK
Cancel

4WPROGRAM FILES (<86)\ COMMON FILES \CAA-TARGETSA\ABE_ACE004ACS00_Vv12\LIBRARY\BUSDIAG LIB

WPROGRAM FILES (KE6)4COMMON FILES\CAA TARGETS\ABE_ACS00ACE00_V1 2\ LIBRARY\SYSINT_ACS00_W10.LE
YWPROGRAM FILES (<86)4 COMMON FILESCAA TARGETSABE_ACS00YACE00_V1 24 LIBRARY\SYSEXT_ACS00_v10.LIB
YWPROGRAM FILES (XG6)\COMMON FILES\CAATARGETSVABE_ACE004ACE00_V1 2\LIBRARY\MODBUS_ACE00_\10.LIB

4 (BB}, COMMON FILES\CAA-TARGE T S4ABE_ACEINACEN_ Y12\ IBRARY\MODBUS_EXT_ACKI0 20 LIB
\PROGRAM FILES (<88)\COMMON FILES\CAA TARGETS\ABE_ACS00\ACS00_Y12\LIBRARYYETHERNET_ACS00_10.LIE

¥ Stuctured

Now, we should have two function blocks in network 0003.

0001
START BITVAL[1]
I {—
BITVAL[2]
)_
0002
BITVAL[4]
{—
0003
blink 297
BLINK COM_MOD_MAST
ENABLE ouT] El DONE]|
[i#2ms < TIMELOW 797<COM ERR[—
[#2ms<TIMEHIGH 777 SLAVE ERNO—
229-FCT
7774 TIMEQUT
?779ADDR.
297 1MB
727 —<DATA
The COM_MOD_MAST is a function block for sending/receiving OpenModbus.
Their definition is available from CoDeSys -> Resources -> Library Manager.
i Library Manager =2 E=R )
SysLibMem.|ib 25.6.18 19:33:14 ~ | [FUNCTION_BLOCK COM_MOD_MAST (*Supported in PLC FW Version V1.0.2 or higher*, A

SysLibinitLibrary.lib 25.6.18 19:33:14
SYSLIBCALLBACKLIB 256.18 19:33:14
BusDiag.lib 25.6.18 19:33:14
Sysint_AC500_V101ib 25.6.18 19:33:14
SysExt_ACS! 0.lip 25.6.18 19:33:14.
MODBUS_AC500_V10.1ib 25.6.18 19:33:14
MODBUS_EXT_AC500_V20.lib 25.6.18 19:33:14

(“Used to send/ received Modbus telegrams via COM interface”

[S

(3 Conversions

[VAR_INPUT
EN: (*1: FALSE->TRUE edge generates a telegram according to the other inputs)
com (*2: COM number*
SLAVE (*3: Slave address (1..265, 0 = Broadcast) *
v Fer (*4: Function code *
TIMEOUT: 5w Tesponse up to TIMEOUT millisecands*)
ADDR: ster address in the slave
NE: ta

DWORD =0;

("8: First operand address of an operand area in the master, from which
data are sentto the slave of data read by the slave should be stored”
END_VAR

<

COM_MOD_MAST

EN:BOOL

com: BYTE
SLAVE : BYTE
FCT . BYTE
TIMEQUT : WORD
[ADDR : WORD
NB . WORD
[DATA - DWORD

DONE : BOOL—
ERR:BOOL—
ERNO : WORD[—

(8 rousf*EData lypes visusizat.. | @ Global Va

To enable this function block, it is required to send a FALSE->TRUE edge at input EN and
therefore we introduce BLINK, which is for creating a flip-flop signal.

STATUS
Approved

© Copyright 2019 ABB. All rights reserved.

SECURITY LEVEL
Public

DOCUMENT ID. REV.

1SFC132092M0201 E

LANG. PAGE

en 24/31




FIELDBUS PLUG

11. DATA (the data to send) require DWORD inputs. We can convert data with a box, “ADR”.

a) Select the bar in front of DATA.

797
COM_MOD_MAST
EN DONEF——

PP COM ERR—
?775LAVE ERNO—
TPIFCT
PP TIMEOUT
P77 ADDR

B

A

b) Choose Insert-> Insert at Blocks-> Box.

| CoDeSys - Application. ACS00PRO®
File Edit Project Insert Extras Online Window Help

H| E|®)]es

=, Resaurces

B3 Global Variab

~§@ Global v
. Wariable_

B[] library Etherne
- fibraty lecsfc|
B[ library Spsint_
B~ libraty SysLibl
B[ library SpsLibt
B~ fibraty SpsLib”
B[ library SpsTas
B~ fibraty Ui ib -
- (57 Tooks

Alarm configu

(17| Library Manar
~~F1] Log

(B PLC - Biowse
-~ (3E) PLC Configur.

6] 5ampling Tran
ﬁ Target Setting

Task configul
Q ‘wiatche and F

'}? ‘Workspace

Declaration Keywords ...
Types ...

New Declaration
Metwork (before)
Network (after)

Contact
Contact (negated)
Parallel Contact

Parallel contact (negated)

Function Block ...
Rising edge detection
Falling edge detection
Timer (TON)

Coil

*Set’ coil
‘Reset’ coil
Box with EN
Insert at Blocks

Jump

Return

Comment

Ctrl+T
Ctrl+K
Ctrl+G
Ctrl+R
Ctrl+D

Ctrl+B

Ctrl+L
Ctrl+1

100 % ~| Il 4k

0001|PROGRAM PLC_P

QUTPUT: BOOI
top_write: ETH.
ERRO: BOOL;

ERMO WORD:

fo lib 25 618 18:33:14

m lib 25.6.18 18:33:14
Library.lip 25.6.18 18:33:14
ALLBACKLIB 25.6.18 18:33:1
ib 25618 18:33:14
500_V10.ib 256 18 18:33:1¢
C500_v10.ib 25.6.18 18:33:1

ACS500_V10.lib 25.6.18 18:33]

&
DNS
General
ChP
Input Ctrl+U
Output
Box
Assign Ctrl+A

The default box is “AND”, change the name to ADR and it will be a ADR box.
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12. Set:

The name of the block to modbus_write.

COM to 1 or 2 deepening on comport used.

FIELDBUS PLUG

Slave to the value of “Fieldbus address” (Parameter 12.4 in PSTX), note that this affects
the baud rate.

FCT to 15.

TIMEOUT to 100.
ADDR to 256, according to Section 3.5, the first Protocol Address is 0100h.

NB to 16.

ERR to ERRO (new BOOL variable).
ERRNO (new WORD variable).

hlink

[F2ms—TIMELO

EMABLE

I

[FF2ms—TIMEHIGH

BLINK

muodhus_write

COM_MOD_MAST

OUT|

EM DOME

COom ERR—ERRD

SLAVE
FCT
TIMEOUT
ADDR

ERNO—ERRMNO

13. Insert a coil named "OUTPUT” in the last network and the LD-program is done.

@y demo (PRG-LD) | =N EeE =]
0004/PROGRAN demo
0002 VAR
0003  STARTBOOL
0004  BITVAL: ARRAY[1.16] OF BOOL;
0005  BLINK: BLINK
0006 modous_write: COM_MOD_MAST,
0007 ERRO:EOOL;
0008 ERRNO: WORD:
0008 OUTPUT-BOOL]
0010/END_VAR
001
001
001
0074
o«
0001
START BITVALH]
| (
| O
BITVALI2]
0002
BITVALI4]
(
{
0003
blink modbus_wiite
BLINK COM_MOD_HAST ouTPUT
ENABLE ouT| EN DONE| ( ),_
#oms {TIMELOW [;¥ com ERR| ‘
2ms-TIMEHIGH [~ & SLAVE ERNO
FcT
ITIMEOUT
ADDR
NB
DATA
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FIELDBUS PLUG

14. Now we want to create one control button for signing the value of “START” from the first
network into TRUE. We do this by Visualization -> right click -> Add object -> Write name

of the new Visualization as “view” -> OK.

Q CoDeSys - Application. ACS00PRO

File Edit Project Insert Extras Online Window Hs
B E@edam g »lE &|m@|

zations

- F'DUsl.T: Data typesl\u’isualizat...l% Hesourcesl

DK'I'}

15. We draw a shape as the button

Regular Element Configuration (0]

sew Visualization

Marme of the new Yisualization: Ivienﬂd

ped

Ok |
Cancel |

-> double click the shape -> Regular Element Config-
uration -> Input -> check Toggle variable -> insert “demo.START” ->OK.

Category:

Bitrmap

Text

Tewt variables
Colorvariables
Y anables

Text far tooltip
Securty
Programmability

— lhput
W Toggle variable |demu::.5T.-‘-‘-.F|T|
[T Tap variable I
[T TapFALSE
[™ Zoom to vis.: I
™ Execute program: |

[T Testinput of variable 'Testdizplay’

ITen-:t vI ki I

_ Carcel |

Cancel

[~ Hidden  Max: |

Diialog title: |
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16. We configure this program into task configuration by Resource -> Task configuration ->
Right click Task configuration -> Append Task -> Insert t#10ms in Properties in Taskattrib-
utes. Then we need to sign our program to this task by right click NewTask-> Append Pro-

gram Call-> Choose demo(PRG) by clicking the select button in Program Call ->OK.

% CoDeSys - Application. ACS00PRO

ile Edit Project Insert Extras Online  Window

Help

| Sl nEda & mw

32, Riesources
13 Global Variables
@ Global_Variables
@ Variable_Configuration [VAR_CONFIG)

#1-(11 fbraiy Ethernst_ACS00_Y10.5b 25518 18:33:14: glol
51 fbraw lecsfe.ib 2.6:14 10:37.46: global variables
(11 fbraiy Sysint_ACS00_V10.ib 25,618 18:33:14: ioba]
(1 fbra SysLiblnitlibrany.Ib 25.6.18 12:3314: global v.
8- lbrary SysLibMem lib 25.6.18 18:3314: global variabl
(] fbrary SysLibTime.lib 25.6.18 18:33:14: global variabl
8- lbrary SysT asklnfo ib 25.5.18 18:33 14: global variab
(10 fbrary UbLib 19.11.14 15:20:48: globial variabies
- 57 Tooks
- [ Alarm configuration

() Libvary Manages
b m Log

(B PLC - Browser
- PLC Configuration

Sampling Trace
- g T arget SeMlings

iguration
-0, Watche and Recipe Manager
3 Workspace

>

<
POLS ™2 Data typee] (] Visuaizal._| §25 Resources]

5] Task

B~ [ Task configuration ~
h 4 System events

b (By: MewTask

Taskattibutes |

Hame:

MNewT ask.
10

Bricrity(0. 31
Type
& pyolic
" heewheeling
" iggered by event
" tiiggered by extemal event

Propetiies

Interval (e.g. t#200ms)  [tH10ms s

‘w/atchdog

[ Activate watchdog
Timele.q tH200ms) %
1

Sensitivi:

figuration
1/0s will not be updated (see target settings)!
n of POU "demo

task ‘MainTask

17. Right click on the NewTask and select Append Program Call.

7 | Task configuration
= [{8 Task configuration A
g Taskattributes
- 2 System events
[ MewTask
: Insert Task
Append Program Call
Cut Ctri+X L
Copy Ctrl+C
Paste Cirl+V  heelin
Delete Del ed by,
Set Debug Task ed by
Enable / dizable task Lo
Interval [eq
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18. Select the demo program call.

|» | Task configuration EI@

B '-?5 ask configuration
: 4 System events
B (Fh NewTask

@ demot); Frogram Call: |dem00; |

Program Call l

1 »

19. Now we can build the project by Project -> Build. Check again if fieldbus is connected cor-
rectly. We can then run the program by pressing ALT+F8 and then F5.

6.4. Connect to PLC using TCP/IP

1. Control the IP address for the device is also correct by right click the device name and then
chose communication setting. The IP address should be the address of PLC CPU device.

Devices -~ 3 X
== pstx V‘
- [ [PLC_PSTX (PM573-ETH - TB521ETH) 1
= @1] pstx_control | Communication Settings...
3 App Source download. ..
10_Bus -
= Interfaces
aste
COM1_Modbus (COM1 - Modbus)
B) com2_online_Access (COM2 - Onli Cut
m FBP_Online_Access (FBP - Online & 3, Delete
ETH
=gy Ethernet Rename
ETH1 (ETH1)
@ Add object
@ Protocols (Protocols)
= @ Extension_Bus Update objects
B siot_1(ras2q) =) Add Folder...
B slot_2(Tas24) 3

[] Edit Object
Compare Objects

Export 3

Check configuration
f

2. Control that the IP address for PC and the PLC is in the same network but not the same IP
address. This can be checked by using through Ethernet Properties.

3. Click the icon “Login”, for building the configuration and checking if configuration is cor-
rect.
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4. If the configuration is correct, a program for building PLC should be opened in the PLC en-
vironment, CoDeSys. Automation Builder will ask for downloading PLC configuration.
Choose “Update”. Automation Builder will confirm that the program has changed.

Automation Builder

The PLC configuration needs to be updated. An update requires full PLC download.
no online change will be possible.

Do you want to update PLC configuration or keep the downloaded PLC
configuration for online change?

Automation Builder 2.1 - Premium

o Lagin

The program has changed! Download the new program?

Update Keep

Yes Mao Cancel

6.5. Build and run the PLC demo program

Use the key, F11, to build the program once. Login and start project from Automation Builder
by clicking Alt+F8 to login the CodeSys. Click yes to login

Login

The program has changed! Do you want to load the changes?
[ONLINE_CHANGE}

Yes Mo Cancel

Click F5 to start. Switch to CoDeSys and click Alt+F8 to login demo. The program can be con-
trolled with the view from CodeSys

®p demo (PRG-LD ===
] A

RRNO
ouTPUT = (B

x
START BITVALIT]
BITVAL[Z]
BITVAL[4]
blink: modbus_write
BLINK COM_IMOD_WAST ouTPuT
E outf Dol —
[#2ms - TIMELOW 1-{com ERRI—ERRO
[#2m=~{TIMEHIGH [~ & ERNO—ERRNO=0
v

5 view = e ]
start/stop
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7. Contact us

For more information, please contact
your local ABB representative or visit
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